
 

 

 

 

 

Microsoft Word 2016  

Beyond the Basics 

Course Notes 

 
 

Sam
ple



 

2017 Chris Page 

i 

 
 

 

 

 

 

 

 

 

 

2017 Chris Page 

 

All rights reserved.  No part of this manual may be 

reproduced, stored in a retrieval system, or transmitted 

in any form or by any means, electronic, mechanical, 

photocopying, recording or otherwise, without written 

permission of Chris Page. 

 

 

Trademarks: All brand names and product  

names used in this manual are trade names,  

service marks, trademarks, or registered  

trademarks of their respective owners.   

 

 

 

 

 

 

 

 

 

 

Chris Page 

11 River Gardens, Shawbury, Shrewsbury, SY4 4LA 

Tel 01939 251094  

www.pagecommunication.co.uk 

Sam
ple



 

2017 Chris Page 

ii 

CONTENTS 
COURSE OBJECTIVES ................................................................................................................................... 1 

MODULE 1 – DOCUMENT LAYOUT ............................................................................................................ 2 
OBJECTIVES ...................................................................................................................................................... 2 
REVISION .......................................................................................................................................................... 2 
QUICK PARTS .................................................................................................................................................... 3 

Auto Text ...................................................................................................................................................... 3 
DOCUMENT LAYOUT ........................................................................................................................................ 5 

Tabs .............................................................................................................................................................. 5 
Indenting ...................................................................................................................................................... 6 
Page Margins ............................................................................................................................................... 7 
Paragraph Spacing ...................................................................................................................................... 8 

DROP CAPITALS ................................................................................................................................................ 8 
PAGE BREAKS AND SECTION BREAKS .............................................................................................................. 9 

Section Breaks .............................................................................................................................................. 9 
Page Numbering ........................................................................................................................................... 9 
Headers and Footers .................................................................................................................................. 10 
Headers and Footers for Different Sections .............................................................................................. 11 

MODULE 2 – TABLES AND COLUMNS ..................................................................................................... 12 
OBJECTIVES .................................................................................................................................................... 12 
TABLES ........................................................................................................................................................... 12 

Creating a Table ........................................................................................................................................ 12 
Drawing a Table ........................................................................................................................................ 12 
Viewing the Table Grid .............................................................................................................................. 13 
Selecting Table Elements ........................................................................................................................... 13 
Moving and Copying .................................................................................................................................. 13 
Lines and Shading ...................................................................................................................................... 14 
Styling a Whole Table ................................................................................................................................ 14 
Re-Sizing Columns ..................................................................................................................................... 15 
Merging and Splitting Cells ....................................................................................................................... 15 
Joining and Splitting Tables ....................................................................................................................... 16 
Inserting and Deleting Rows or Columns .................................................................................................. 16 
Heading Rows ............................................................................................................................................ 16 
Convert Text to Tables or Tables to Text ................................................................................................... 17 

TEXT COLUMNS .............................................................................................................................................. 18 
Activating Columns .................................................................................................................................... 18 
Adjusting column spacing and width using the mouse and ruler ............................................................... 18 
Moving Between Columns .......................................................................................................................... 19 
Balanced Columns ..................................................................................................................................... 19 
Switching Off Columns ............................................................................................................................... 19 
Parallel Columns ....................................................................................................................................... 19 

MODULE 3 – STYLES AND LISTS .............................................................................................................. 20 
OBJECTIVES .................................................................................................................................................... 20 
STYLES ........................................................................................................................................................... 20 

Applying Styles ........................................................................................................................................... 20 
Creating and Editing Styles ....................................................................................................................... 22 
Style Selection Shortcuts ............................................................................................................................ 23 
Copying Styles between Documents ........................................................................................................... 23 

USING STYLE SETS ......................................................................................................................................... 23 
Themes ....................................................................................................................................................... 24 

BULLETS, AND NUMBERED LISTS ................................................................................................................... 24 

MODULE 4 – NOTES, TABLE OF CONTENTS, INDEXES AND TRACKING ..................................... 26 
OBJECTIVES .................................................................................................................................................... 26 

Sam
ple



 

2017 Chris Page 

iii 

COPYING OBJECTS USING THE CLIPBOARD.................................................................................................... 26 
FOOTNOTES AND ENDNOTES .......................................................................................................................... 26 

Move or copy a footnote or endnote ........................................................................................................... 27 
TABLE OF CONTENTS ...................................................................................................................................... 27 
INDEX ............................................................................................................................................................. 28 

Index Automark File ................................................................................................................................... 28 
Manually Marking Index Entries ............................................................................................................... 29 
Defining the Index Location and Page Numbering Style ........................................................................... 30 
Updating Tables of Contents and Indexes .................................................................................................. 30 

TRACKED CHANGES AND PROTECTING DOCUMENTS .................................................................................... 30 
Tracked Changes ........................................................................................................................................ 30 
Sending Documents outside the Company ................................................................................................. 33 
Printing Tracked Changes ......................................................................................................................... 33 
Protecting Documents ................................................................................................................................ 34 

CREATING BOOKMARKED PDF DOCUMENTS ................................................................................................ 35 

  

Sam
ple



 

2017 Chris Page 

1 

COURSE OBJECTIVES 

By the end of this course you will be able to 

 Accurately edit a document to include specified paragraph setting, and headers and footers, for 

different parts of the document referring to notes if necessary. 

 Correctly create a specified table within a document, without reference to notes. 

 Correctly create text in newspaper-style columns, referring to notes if necessary. 

 Correctly use and modify specified styles, referring to notes if necessary. 

 Accurately create and modify a numbered list, referring to notes if necessary. 

 Accurately create footnotes and endnotes, referring to notes if necessary. 

 Accurately create a table of contents and index for a document, referring to notes if necessary. 

 Correctly set up tracked changes in a document, without reference to notes. 

 Correctly create bookmarks in a document and incorporate them in a PDF version of the 

document, referring to notes if necessary. 
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MODULE 1 – DOCUMENT LAYOUT 

OBJECTIVES 

At the end of this section you will be able to: 

 Accurately edit a document to include specified paragraph setting, and headers and footers, for 

different parts of the document referring to notes if necessary. 

REVISION 

Word 2016 is a very powerful 

word-processor. If you have used 

it for some time, you will 

appreciate that it has very many 

features that take it beyond simple 

word-processing and very close to 

desk-top publishing. It 

incorporates graphics drawing 

facilities, mathematical equation 

building, charting and simple 

spreadsheet capabilities. This 

course will take you beyond the 

simple word-processing facilities 

into the areas that will help make 

the every-day user into a power 

user of Word 2016.  

It is worthwhile revising some Word 2016 basic features before proceeding on to the other areas. 

Insertion Point 

The Insertion Point is a small flashing vertical bar on the text area of the screen and shows where the 

next character you type will be placed. 

Mouse Pointer 

When mouse pointer is moved over the text area, it changes shape to a large upper case I and is called 

the I-Beam.  When it is moved over the menu areas it changes to an arrow and is the Mouse Pointer. 

Touch Mode 
Touch Mode spaces the buttons a little farther apart on the screen, so 

they’re easier to tap if you are using a tablet. You can turn on Touch 

Mode by tapping the Touch Mode button on the Quick Access Toolbar. 

If you don’t see the button or the icon on the Quick Access Toolbar, 

you can add it as detailed earlier. 

To turn Touch Mode off, tap the Touch Mode button again. Or tap the 

Touch/Mouse Mode hand icon and tap Mouse. 

The Ribbon 

The Ribbon is designed to help you quickly find the commands that you need to complete a task. 

Commands are organized in logical groups, which are collected together under tabs. Each tab relates to 
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a type of activity, such as writing or laying out a page. To reduce clutter, some tabs are shown only 

when needed. 

You can minimize the Ribbon to make more space available on your screen, and you can customise it. 

Status Bar 

The Status Bar is displayed at the bottom of the screen.  This shows you the page number and the 

number of pages in the document, and the word count. Other information can be displayed on the status 

bar by right-clicking on it and selecting other items. 

Scroll Bars 

The vertical scroll bar lets you scroll through the document by clicking on the arrows at the top or 

bottom of the scroll bars.  Holding down the mouse button will result in continuous scrolling.  By 

clicking on the scroll bar above or below the scroll box, the document scrolls up or down one screen at a 

time.  Clicking on the double arrow icons below the vertical scroll bar will scroll through one document 

page at a time. The scroll box can be dragged to any point on the scroll bar to reposition in the 

document.  As this is done so the page number will be displayed next to the scroll box as a Tool Tip. 

The horizontal scroll bar works in very much the same way as the vertical scroll bar except that it 

moves your view of the document to the left or to the right. 

The Ruler 

The horizontal portion of ruler is displayed below the Toolbar, and the vertical portion is displayed to 

the left of the document (in Print Layout view only.)   

To show/hide the ruler 

1. Click on the View tab of the Ribbon and click on the Ruler check box in the 

Show/Hide group. 

The unit of measurement is by default in centimetres but can be changed to inches, 

millimetres, points or picas.   

To change the unit of measurement 

1. Click on the File tab, and then click on the Options button.  

2. Select the Advanced section, then go to the Display section. 

3. Click on the Show measurements in units of drop-down selector and make your 

choice. 

Document Views 

Document views allow you to change between Read Mode, Print Layout View, Web Layout View, 

Outline View and Draft View. While in Print Layout View you can hide/show the white space, that is 

the top and bottom margin areas of each page.  

QUICK PARTS 

Auto Text 

AutoText is reusable content that you can store and access again, and again. For example it could be a 

standard contract clause, distribution list for memos and so on. You can store text, graphics, or anything 

else you've created in Word in AutoText and give it a name, preferably something short and memorable. 
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To create a new Auto Text entry 

1. Select the content you want to save as AutoText. Your selection can include text, 

pictures, and other objects that Office recognizes. There's virtually no size limit. You 

could even use an entire document as AutoText. 

2. Use A+3 to open the Create New Building Block dialog box, or on the Insert tab, in 

the Text group, click on the Quick Parts button.  

3. Select Auto Text and click on Save Selection to AutoText Gallery. 

4. The Create New Building Block dialog is shown.   

5. There are six boxes in the dialog box, 

but the first one, Name, is the most 

important. The name is the key used to 

retrieve the AutoText. The name can be 

as short or as long as required. For 

speed's sake, shorter is better, but do 

not make it so cryptic that you cannot 

remember it.  

6. A description is optional. If you create 

a lot of AutoText, then you may find it 

helpful to store them in different 

categories as a way to organize them. 

For example, you can create a Help 

Desk category with answers to frequently asked questions and a Contracts category with 

a legal text. 

7. You can leave the Save in drop-down menu set to Normal.dotm. The AutoText is saved 

in that file which is a Word template that's available to any document. On the other hand 

you can change it to the alternative Building Blocks.dotx. 

8. From the Options menu, choose how you want the text to appear every time you press 

3. The options are: 

 Insert content only, is a good one to use if you plan to use the Quick Part within 

paragraphs.  

 Insert content in its own paragraph, works well for address blocks or entire 

paragraphs, such as the answers to frequently asked questions.  

 Insert content in its own page, is a logical choice for a memo or other text that 

rightfully belongs on its own. 

9. Finally, click on OK. 

To insert a Quick Part or AutoText 

1. As you type an autocomplete suggestion will display when 

Word has guessed what you might be typing – an example 

is shown here. Just press R to accept the suggestion, 

or press E to reject it. 

If you do not want these auto suggestions displayed, click on the File tab, and then click 

on Options. Select the Advanced section and go to the Editing section. Clear the check 

box beside Show Autocomplete suggestions. 
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2. Alternatively, type the AutoText/ Quick Part name and press 3, or on the Insert tab of 

the Ribbon in the Text group, click on the Quick Parts button and scroll to the item and 

click on it, or for AutoText click on AutoText and scroll/click on the required item. 

DOCUMENT LAYOUT 

Tabs 

Word sets default tab stops every1.27cm (½") from the left margin. The tab stops default setting can be 

changed at any time. Additional tab stops can be added and are seen on the Ruler as the relevant tab 

markers as illustrated above. The Tab settings can assist text alignment on the page and is particularly 

useful when using proportionally spaced fonts.  The shape of each tab marker on the Ruler Bar shows 

the type of tab stop it is. The different types of tab are shown here. The easiest way to set or change tabs 

is by using the mouse and the Ruler as you can see where the tab stops are being put on the page. Move 

the Insertion Point to the start of the text where you want to change the tab settings. 

Setting tabs using the mouse on the ruler 

1. Select the type of tab stop required by clicking on 

the tab symbol at the left side of the ruler. Each 

click will display a different symbol. Once the type 

of tab has been changed subsequent selections of a 

tab stop will be of the new type. 

2. Move the mouse pointer to the bottom part of the 

ruler with the tab markers on. 

3. Click the left mouse button where you want the tab 

stop to be.  Any default tab stops to the left of this 

new tab stop will be deleted. 

4. Repeat 2 and 3 for as many tab stops that you 

require.  This does not apply for the first line indent 

and the hanging indent selections. 

Setting tabs using the tabs dialog box 

1. Double-click on any tab stop on the ruler or in the Home tab, click on a Paragraph 

group Dialog Box Launcher and then click on the Tabs button at the bottom-left of the 

displayed dialog. 

2. The various tab settings will be shown. These can be added to by entering the required 

tab position in the Tab Stop Position input box.  First line indent and the hanging indent 

selections cannot be made in this dialog box. 

3. Click on Set and repeat these steps for each new position. 

4. Click on OK to finish. 

Editing and moving tabs 

Tab stops, other than default tab stops, can be cleared individually and moved to new positions. 

  1. To move a tab marker, drag it on the ruler to its new position. 

2. To delete a tab marker, drag it downwards off the ruler. 

 

Left aligned tab 

Centre aligned tab 

Right aligned tab 

Decimal tab 

Bar tab 

First Line indent 

Hanging indent 
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Leader tabs 

Leader Tabs insert a series of dots, dashes or lines in the spaces normally left blank when pressing the 

T key as you type.  Open the Tabs dialog box. The various tab settings will be shown. Select the 

required tab position to be made a leader and then select the required leader style. This type of tab is 

most effective when most other tabs have been cleared. You will have to experiment to achieve desired 

results. 

Clearing all tabs 

You may wish to return to using just the default tab stops. 

1. Double-clicking on the bottom half of the ruler displays the Tabs dialog box. 

2. Select Clear All in the Tabs dialog box. 

3. Click on OK. 

Indenting 

Indenting only affects the current or selected paragraph. Indenting is based on the currently set tab stops 

and is where a line or lines of text are moved in by one or more tab stops thus affecting the layout of a 

single paragraph. A paragraph can be a single character, a word, a line of text or multiple lines of text.  

What defines a paragraph is simply that the R key has been pressed to start a new line rather than 

let word wrap continue the text on a new line. Paragraph spacing is the number of lines between 

individual paragraphs. 

Left side only 

To indent the entire left side of the paragraph, click on the Increase Indent button 

found on the Home tab of the Ribbon in the Paragraph group. Every click 

increases the indent by a tab stop. Every click on the Decrease Indent 

button moves the left side of the paragraph one tab stop to the left. 

Alternatively, drag the square left margin marker on the left side of the 

ruler. 

 

 

First line indent only 

To indent the first line of the left side of the paragraph only - this is called a First Line Indent - 

drag the First-line indent marker to the required position, or select the First-line indent symbol to 

the left of the ruler and then click on the ruler where you want the First-line indent to start. 

Decrease   Increase 

Indent       Indent 

 

   

First-line indent 

marker 
 

Hanging indent  

marker 
  

Left margin marker 

 

 

Right margin marker 
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EXERCISE 1  

1. Open the file SpeedHumps 

2. You are now going to create a cover page at the beginning of the document. Do this by inserting 

a page break at the beginning of the document.  On this new front page type a centre aligned title 

that reads: 

 

Report on Speed Humps 

 

3. Add a header on all pages which is centre aligned and emboldened and looks like the following: 

 

SPEED HUMPS REPORT 

 

4. Add a footer on all pages with some text and page numbers centre aligned which looks like the 

following (remember the page number is a code not the number 1!): 

 

The Speed Safety Unit 

1 

 

5. Now edit the header/footer so it has a different first page. This has the effect of not showing 

what you have created on the first page, keeping the cover page looking neat. Make sure the first 

page of the body of the report has page numbering set up so the number starts at 1 (i.e. you have 

pages 1 to 5 with a preceding cover page with title on). 

 

6. Close and save the changes. 
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EXERCISE 2  

1. Create the following table. 

2. Pay particular attention to the alignment of the various cells and the line styles used for the 

borders.  

3. Close and save the file as FURNITURE LIST 

 

 

FURNITURE LIST 

 

Item Stock No Quantity 

Executive Desk 9009-12 45 

Chair 9009-23 45 

Bookcase 9009-55 12 
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